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Overview of Hyperlinking in Federal Court 
 

In the internet research world, hyperlinks are a standard way of “drilling down” for 

more detail or specific information.   Just as all web pages contain links to other pages, 

cases downloaded from legal research services such as W estlaw or Lexis contain links 

to the cases, statutes, articles, or other sources cited within the opinion.  The links allow 

immediate access by the reader to these referenced materials. 

 

Attorneys can include links to cited law and CM/ECF filings in their briefs filed in 

CM/ECF,  adding another level of persuasion  to their writing.   Hyperlinks  in briefs and 

other court filings provide quick, easy, and pinpoint  access to particular  sections  of a 

case, or to specific filings in the court’s record.   The attorney can thereby highlight the 

precise issue presented, and the specific evidence and controlling or persuasive law the 

court should consider. 

 

Hyperlinks   in  court  filings   are  very  beneficial   for  court  chambers.     Court 

submissions  which  include  links  to relevant  case  law  and  case  filings  are  easy  for 

chambers staff to review.  The attorneys’ arguments can be immediately verified in the 

context  of the relevant law.   The judge or judicial clerk is able to read the text of the 

cited case law on one screen while reading the attorney’s brief on the other.   And if a 

brief  contains  links  to referenced  exhibits,  and  even  to  specific  pages  within  those 

exhibits, the judge or judicial clerk can access the relevant evidence without having to 

navigate through the CM/ECF record.  Particularly when dealing with large and complex 

cases, links save chambers  considerable  time and effort.   Links  make it easy for the 

court to verify – and adopt – the positions taken by an advocate. 
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Types of Permissible Hyperlinks 
Subject to the court’s local rules, the following types of hyperlinks are typically 

allowed in court documents. 

 
Internal Links  For example, the Table of Contents located at the 

beginning of this Guide. 
 

Links to documents 

previously filed on CM/ECF 
 
 
 

Links to attachments and 

exhibits being filed with your 

brief 
 

 
 

Links to case and statute 

citations 
For example: 
 

Westlaw, 
 

 
 

Lexis, 
 

 
or court websites. 
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Creating a Hyperlinked Table of Contents 
 

A table of contents in a W ordPerfect document can include internal hyperlinks for 

navigating the document.  The following steps are used to create a Table of Contents in 

a W ordPerfect document. 
 

Step 1:  Mark all of the items that belong in the list. 

Step 2:  Insert a page break before the list and add a title or page header. 

Step 3:  Define the format and position for the list. 

Step 4:  Generate the list and cross-references. 

Step 5:  Edit the generated list. 
 

Marking Table of Contents Entries 

Follow the steps below to mark entries for a table of contents (TOC). 
 

 

STEP 
 

ACTION 

1 On the Tools menu, point to Reference and then Table of 

Contents. 
 
Note: The Table of Contents Feature Bar appears. 

2 Select the block of text to include in the table of contents. 

Note: This is best done using Reveal Codes, being careful with any 

formatting codes. 

3 Click the Mark button on the Feature Bar to choose the indentation 

level you want for the selected text.  There are 5 Mark buttons 

which correspond to five levels of indentation.  The leftmost 

position in the table of contents is level 1. 
 

Note: W ordPerfect will mark the selected text with [Mrk Txt ToC] 

codes which you can see in Reveal Codes. 

Defining a Table of Contents 

Follow the steps below to define the position and format for a table of contents. 
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STEP 
 

ACTION 

 

1 Turn on the Table of Contents Feature Bar (Tools➔Reference➔Table 

of Contents) 
 

2 Move the cursor to the point where the table of contents should appear. 

Note:  To start the table on a new page, press Ctrl+Enter.  Press ↑to 

move the cursor before the [HPg] code.  Enter a title if you'd like one, 

such as Table of Contents, and press Enter. 
 

3 
 

Click the Define button on the Feature Bar to open the Define Table of 

Contents dialog box. 

 

4 
 

Use the following options to customize your table. 
 

Number of Levels Allows you to choose how many levels to 

display in the table of contents, from 1 to 5. 

Position Allows you to choose where to place page 

numbers in each level. 

Styles Allows you to customize the appearance of 

the text in each level. 

Page Numbering Lets you customize the page numbering 

format. 
 

5 
 

Click OK to return to the document window.  The message <<Table of 

Contents will generate here>> will appear at the cursor position. 
 

6 
 

To ensure proper page numbering, move the cursor to the top of the 

first numbered page (the first page that follows the table of contents). 

From the Format menu, click Page, then Numbering and click the Set 

Value button. 

 

7 
 

Click the Page tab, change Set Page Number to 1, and click OK. 

Generating Lists 

Once you've marked your lists, generating them is easy.  Follow the steps in the 

table below to generate the table of contents. 
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STEP ACTION 

1 Click the Generate button on the Feature Bar.  Or from the Tools 

menu click Reference, then Generate. 

2 If you want, select or clear the following options: 
 

Save Subdocuments: W ordPerfect saves changes to 

subdocuments of the master document being generated. 
 

Build Hyperlinks: W ordPerfect generate and saves hyperlinks in 

your document. 

3 Click OK. 
 

Warning: W ordPerfect does not update the lists automatically when 

you change the document. Be sure to regenerate the list after 

making changes. 

 

Editing Lists 

If you decide to edit a generated list, pay special attention to the codes that 

define the list and its contents.  You'll typically see codes like these after you 

generate a list. 
 

[Def Mark][Gen Txt].....list goes here....[Gen Txt] 
 

Each list begins at the [Def Mark] code that W ordPerfect inserts when you define 

the list.  The generated list appears between the [Gen Txt] codes.  Each time you 

generate a list, W ordPerfect will replace all of the text between the sequence of 

codes.  You should, therefore, keep the following in mind. 
 

• Always place list titles and page headers before the [Def Mark] code, not 

after it, or between the [Gen Txt] codes.  (Otherwise they will disappear 

when you regenerate the list) 

• If you edit the generated list only, your changes will be lost when you 

regenerate the list.  Therefore it is best to edit the references within the 

main document and then regenerate the list. 
 

When the entire document is complete, using MS W ord, Save the document as a 

PDF or Create PDF in accordance with the instructions in this Guide. 
 

Note:  Do not Print to PDF.  All active links in your Word document become 

inactive in PDFs created using Print to PDF. 
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Drafting Documents to Include Links to CM/ECF 
 

If you intend to include CM/ECF links in a document you are creating, use a 

consistent citation format that cites the CM/ECF filing number along with the CM/ECF 

page number.  For example: 
 

1 Download   the  filings   from  CM/ECF,   and  save   them   in  your   computer. 

Reminder:  you  can  download  a document  from  CM/ECF  one time for free 

when  you  receive  the  notice  of  electronic  filing.    Charges  apply  to  each 

additional download of the same document. 

2 Documents downloaded from CM/ECF will include a header that identifies the 

CM/ECF filing number and the page numbers within that filing. 

3 When drafting your brief, cite to the CM/ECF filing number and CM/ECF page 

number to which you are citing.  For example: 

Assume you are citing to the following page of evidence. 

 

The citation within the brief could appear as follows: 
 

The Plan included a Trust Agreement.  (Filing No. 13-1, at CM/ECF p. 3). 

 

Gathering Links for Citations to the Record 

Now that the filing numbers and associated page numbers are in the brief, you 

can manually add links to the electronic record. 
 

To obtain the url for the document without incurring a PACER charge: 
 

1  Collect and save on your computer the notice of electronic filing (NEF) for all 

filings in the case. 

2  When you later need the link for the 

document cited, 

--retrieve the NEF for that document, 

--right-click on the Document Number, and 

from the drop-down menu that appears, 

Select Copy Shortcut. 



Attorney Guide to Hyperlinking in the Federal Courts 

Revised on June 6, 2014 Page 8 of 30 
 

To obtain the url for the document from the PACER docket sheet (PACER 

charge applies): 
 

STEP  ACTION 
 

1  Open the CM/ECF docket sheet and scroll to the cited docket filing. 
 

 
 

2  If linking to the main CM/ECF filing, 
 

right-click on the docket filing number, 
 

 
 

and  Copy shortcut. 
 
 
 

If linking to a sub-file within a CM/ECF filing number: 

Either: 

Click on the docket filing number; 

 
 

A window will open which lists all sub- 

filings  for that docket filing number. 

 
Place your cursor over the link for the 

document you are citing, 

 
right-click, and from the drop-down 

menu that appears, and 
 

select Copy Shortcut. 
 

 
 

Or 
 

Right-click on the sub- 

filing number in the 

docket text and, 
 

 
 

select Copy Shortcut. 
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Formatting the appearance of the links inserted 

Before inserting links into a document, you may choose how those links will 

appear in the final document.  For example, do you want them to appear: 

blue and underlined, 

bold and black, 

black and italicized, or 

some other appearance? 

To select the appearance of the links in your document: 
 

STEP ACTION 

1 Open a W ordPerfect document which 

includes hyperlinked text. 
 
 

From Format on the menu bar, 

Select Styles. 

2 In the Styles box, 
 

scroll to and select Hypertext. 

Click Edit. 

3 
 

The Styles Editor box 

will open. 
 
 

Double-click on a 

Reveal Codes command in the 

Contents box; e.g. on 

 or . 

4 
 

The Font Properties 

box will open. 
 
Select the desired Color. 

 
Select the desired Appearance. 

 
Click OK. 
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STEP  ACTION 
 

5  You will return to the Styles 

Editor box. 
 

 
 

Click OK. 
 

 
 
 
 
 
 
 

6  You will return to the Styles 

box. 
 

If you want to set your 

changes as the hyperlink 

text format for every 

document, 
 

Click on Options, and from 

the drop-down that appears, 
 

Select Settings. 
 

7  In the Style Settings box, 

Select Default Template. 

Click OK. 
 

 
 
 
 

8  You will return to the Styles box. 
 

 
 

Click Close. 



Attorney Guide to Hyperlinking in the Federal Courts 

Revised on June 6, 2014 Page 11 of 30 
 

Linking to CM/ECF Documents 
 

Inserting Links to Documents Previously Filed on CM/ECF 

To manually add the links you have copied from the docket to the MS W ord 

document you are drafting: 
 

 

STEP  ACTION 
 

1  In the brief, use your cursor to select the citation you want to link. 
 
 
 

2  From Tools on the menu bar, 

select Hyperlink. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3  A Hyperlinks Properties dialog box will appear. 
 

 
Use   the   Delete   key 

from the computer 

keyboard to remove 

 
 
 
 
 

 
4  Right-click in the 

Document/Macro box. 

Select Paste. 
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STEP ACTION 

5 
 

The link to the first page of 

the filing will appear. 
 

To link to the filing only, or 

to only page 1 of the filing, 
click OK. 

 

The link to the citation will 

be added in your brief. 

6 
 

To link to the specific page number of a CM/ECF filing to which you are citing, 
 

In the address box, scroll to or place your cursor at the end of the link 
address. 

 

Add the following text: ?page=<page number> .  For example, 
 

 
 

To link to page number 3 of a filing, add ?page=3.   Click OK and the 
link to the page will be added to the citation in the brief. 

 

Note:  W hile the document remains in W ordPerfect format, the link will 

go only to the first page  of the document.   But upon conversion  to 

PDF, the PDF link will go to the specific page you cited. 

7 
 

Convert the brief to a PDF following the instructions below. 

8 
 

File the PDF version of the document in CM/ECF. 
 

Note: It is not necessary to re-file or re-attach the documents to which 
you are linking to if they have been previously filed in CM/ECF. 

 

Adding Links to Attachments to the Document Being Filed 

If a document cited in your brief has not previously been filed on CM/ECF,  you 

may link to the document within your brief only if the document is filed as an 

attachment to your brief. Follow the steps below to add active hyperlinks to 

documents you will be filing as brief attachments in CM/ECF. 
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STEP 
 

ACTION 

1 
 

Save all the documents you will cite to into a single folder in your 

computer. The documents must be in PDF format. 

2 
 

While drafting your brief, include the citations to the documents saved 

in your computer. 

3 
 

In W ordPerfect, select the text to which a link will be added. 

4 
 

From the Tools menu, select Hyperlink. 

5 
 

A Hyperlinks Properties dialog box will appear. 

Click the folder button. 

 
 

Browse to and select the saved file you want to link. 
 

 
 

Click on the file.  The name of the file will appear in the File name box. 
Click Select. 

 

(Note: The file selected as the link must be in PDF format.) 
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STEP  ACTION 
 

6  The path to the file will appear in the Document/Macro field. 
 

 
 

7  A link to the file will be added to the text. If you hover over the link with 

your cursor, you will see the link address. 
 

 
 

Add links accordingly to all the citations in your brief. 
 

Note: Specific page links can be added by following the directions in 

the previous section. Use the PDF page number, not a Bates number 

or footer page number, for the citation. 
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STEP  ACTION 
 

8  File the brief and evidence as follows: 
 

 

a 
 

Following the normal procedure for filing briefs on 

CM/ECF,  browse to and select your brief with links as 

the main document. 

 

b 
 

Browse to and select as an Attachment each PDF file 

to which a link was created in your brief. 

 

c 
 

Using the drop-down list, select the type of document 

attached, and provide a written description of the 

document.   (Note:   From the court’s perspective, the 

written  description  you  provide  in  CM/ECF  can 

become, automatically, the name of a PDF bookmark in 

the downloaded file). 
 

 

Repeat  the foregoing  steps  until  all cited  evidence  is 

filed as an attachment to your brief. 

 

d 
 

When  all  evidence  attachments  have  been  added  to 

the brief, click Next and complete the remaining steps 

for filing the brief on CM/ECF.  Once filed, the links in 

the brief will link directly to the evidence filed of record 

with the brief. 
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Automated Links to Legal Citations 
 

Links to legal citations can be added manually or, assuming the software is 

compatible  with  your  computer  and  word  processing  software,  by  using  automated 

linking software available through W estlaw or Lexis. 
 

Access to Linking Software 
 

Tool Cost URL 

W estlaw InsertLinks Must purchase a W est 

BriefTools subscription. 

Estimated cost:  $100/month 

for small firms; 

$300 to 500/month for larger 

firms (10 licenses) 

http://legalsolutions.thomsonre 
uters.com/law- 
products/solutions/brief- 
tools?searchterms=brief+tool 

Shepard’s Links 

2008 

Lexis is currently not selling a 

software subscription which will 

insert links to documents that 

will remain active upon 

conversion to PDF.  The last 

version of such software was 

created in 2008 and can be 

downloaded from the 

Lexis/Nexis website for free. 

http://support.lexisnexis.com/ln 
download/record.asp?ArticleID 
=6056 

 
 
Note: The Shepard’s 
BriefSuite dictionary is getting 
old and may not recognize 
some of the newer reporters. 

Its accuracy as a linking tool is 
inconsistent. 

Lexis for Microsoft 

Office 

This Lexis software product will 

add links for research and 

drafting purposes, but those 

links are lost upon conversion 

to PDF.  Lexis is investigating 

the issue. 

http://www.lexisnexis.com/en- 
us/products/lexis-for-microsoft- 
office.page 

http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief%2Btool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief%2Btool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief%2Btool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief%2Btool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief%2Btool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief%2Btool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief%2Btool
http://support.lexisnexis.com/lndownload/record.asp?ArticleID=6056
http://support.lexisnexis.com/lndownload/record.asp?ArticleID=6056
http://support.lexisnexis.com/lndownload/record.asp?ArticleID=6056
http://support.lexisnexis.com/lndownload/record.asp?ArticleID=6056
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
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Linking Software—Compatibility Information 

The following  graph  outlines  the  compatibility  of  Shepard’s  Links  2008,  W est 

InsertLinks, and Lexis Links for Microsoft Office for inserting links into MS W ord 

and W ordPerfect documents with a W indows XP (SP3) 2GB Memory, W indows 

Vista (SP2) 4GB Memory, or W indows 7 – 4GB Memory computer.* 
 

Shepard’s Links 

2008 

Lexis for 

Microsoft Office 

West 

InsertLinks 

MS Word 2010  X**  X*** 
 

MS Word 2007  X**  X*** 
 

MS Word 2003  X  X*** 
 

MS Word 2000  X 
 

WordPerfect X6**** 
 

WordPerfect X4 – X5  X 
 

WordPerfect X3  X  X 
 

WordPerfect 10 – 12  X   
 

*    The W est and Lexis linking software programs cannot be used on Apple computers. 

Moreover,  although  Shepard’s  Links  was  not designed  to operate  on W indows  Vista 

and W indows  7 (as reflected  in the Lexis  literature),  it is working  on these computer 

systems. 
 
** Lexis  for Microsoft  Office is being  developed  and tested.   However,  in its current 

stage of development,  any links added by Lexis for Microsoft Office are being stripped 

out upon conversion to PDF.  Lexis is investigating this issue. 
 
*** W estlaw product information states InsertLinks is compatible with both 32- and 64-bit 

Microsoft W ord.   However,  while it works well with 32-bit W ord, InsertLinks  is not fully 

compatible or useful with 64-bit W ord. 
 
**** W est  currently  has  no linking  software  compatible  with W ordPerfect  X6.   W est 

indicates it may develop and release this product during the summer of 2013. 
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Westlaw InsertLinks 

InsertLinks is a W estlaw computer software program which scans Microsoft W ord 

or Corel W ordPerfect
1  

documents to locate legal citations, and then automatically 

inserts hyperlinks to the W estlaw internet address (url) for those citations into the 

word processing document. 
 

See attached InsertLink example-W ord 
 

InsertLink example-W ordPerfect 
 

Installing West InsertLinks 

InsertLinks is part of the W est BriefTools suite, and a BriefTools 

subscription is required in order to use this software. 
 

• The current W est BriefTools product is Version 2.7.2039, which 

was updated on December 10, 2012. 
 

• The attached BriefTools Software Download instructions 

outlines the system requirements and provides instructions on how 

to install W est BriefTools. 
 

Using West InsertLinks 

Once InsertLinks software is installed, W estlaw links can be installed 

automatically in W ordPerfect documents using the following steps: 

 
STEP  ACTION 

 

1  With the W ordPerfect document to which you are adding links 

open on your screen: 
 

 
 

Select Insert Links from the menu bar. 
 

 
 
 
 
 
 

1 
Currently, InsertLinks is not compatible with, and cannot be used for, automatically inserting links into 

WordPerfect X6 documents.  It does, however, work with prior versions of WordPerfect. 
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STEP  ACTION 
 

2  The InsertLinks  software  will begin  searching  the document 

for citations and inserting the appropriate links. 
 

 
 

3  The Inserting Links box depicted above will disappear when 

the process is complete and all links are installed. 

 
 
 

Shepard’s Links 2008 

Shepard’s Links is a Lexis computer software program which scans Microsoft 

W ord or Corel W ordPerfect
2  

documents to locate legal citations, and then 

automatically inserts hyperlinks to the Lexis internet address (url) for those 

citations into the word processing document. 
 

Reminder:  Although free, Shepard’s links has not been updated since 2008 and 

provides inconsistent auto-linking results. 
 

Installing Shepard’s Links 

Shepards Links is part of the Shepard’s BriefSuite. 
 

• Shepard’s BriefSuite has not been updated since 2008. 
 

• The attached BriefSuite software download instructions 

provides a step-by-step description on how to install Shepard’s 

BriefSuite. 
 
 
 
 
 
 
 

2 
See compatibility graph above. 
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Using Shepard’s Links 

Once Shepard’s Links software is installed, Lexis links can be installed 

automatically in W ordPerfect documents using the following steps: 
 

STEP  ACTION 

1 
 

Click on the Shepard’s Link button, circled in the screenshot 

below 

2 
 

Click the checkbox (optional) and click OK. 

3 
 

Click Cancel.  Logging in is optional. 

4 
 

Click OK. 
 

 
 
 
 
 
 
 
 
 
 
 

5 
 

The new document  with the hyperlinks  opens  in a new tab. 

Save   the   document   as   a   PDF   as   described   in   these 

instructions. 
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Manually Inserting Hyperlinks 
 

As  previously  described,  hyperlinks  to  documents  filed  on  CM/ECF  can  be 

manually  added  to  a  document.     It  is  also  possible  to  manually  create  links  to 

documents  available through commercial  legal websites  (e.g., Lexis or W estlaw),  and 

those posted on the court’s website (Local Rules). 
 

Manually  adding  links  can be labor  intensive  if the document  is long,  but the 

process is not difficult.  And even if you are primarily using software to add links to a 

document, understanding the underlying mechanics  of hyperlinking within W ordPerfect 

and W ord documents  is helpful  and may be necessary  if, for  example,  you  need  to 

make corrections to the automatically created links. 
 

Manually Creating Links to Online Research Resources 

The process for manually adding links to W estlaw, Lexis, Google Scholar, or any 

other online research resource (LoisLaw, FastCase, etc.,) is the same. 
 

STEP ACTION 

1 In the brief, use your cursor to select the citation from which you want 

to link. 

2 Sign into the legal research website and open the cited document. 

Select the url address for the document. 

Right-click, and Copy the address.  See e.g., 
 

 
 

OR 
 

 
 

 
Note:  Check your local rules for any authority or limitations on the 

legal research websites to which links are permitted. 

Note:  Some attorneys have reported difficulty using this method to 

insert links to Lexis research.  An alternative option is described in 

Appendix A. 
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STEP ACTION 

  

a 
 

From Tools on the menu bar, 

select Hyperlink. 

 

 

 

b 
 

A Hyperlinks 

Properties dialog box 

will appear. 
 

Use the Delete key from 

the computer keyboard 

to remove 

 

c 
 

Right-click in the 

Document/Macro box. 

Select Paste. 

 

d 
 

Click OK. 

 

e 
 

The link to the citation will be added in your brief. 

 

 
 
 

3 
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Manual Links to Court Websites 

You may wish to cite to published opinions on a court’s website, or to the court’s 

local rules.  To do so: 

 
STEP  ACTION 

 

1  In your brief, select the text to be linked. 
 

 
 
 
 

2  Locate and copy the url address for the citation.  See e.g., 
 

 
 

OR 

 
 

3  Referring to the previous section, “Manually Creating Links to 

Online Research Resources,” complete Step 3. 
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Create Bookmarks in a PDF 
A bookmark is a type of link within Acrobat PDF documents. Each bookmark 

goes to a different view or page in the document. They can mark places in a 

document for easy access later.  Follow the steps in the table below to add 

bookmarks to your PDF files. 
 

 

Step 
 

Screen 
 

1.  Click the Bookmark tab on the left 

side of the window to open the 

bookmarks panel. 

 
 

 
 

2.  Navigate to the page where you want 

the bookmark. 
 
 

In the Bookmarks pane, click the New 

Bookmark icon. 
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3.  A new bookmark will appear as 
 

 
 

Type a name for the bookmark. 
 
 
 

Note:  If you highlight text on the page 

before clicking the New Bookmark 

button, the selected text will 

automatically become the name of the 

bookmark. 

 

 
 

 

4.  Repeat steps 2-3 until all bookmarks 

are placed. 

 

 

To ensure that the bookmarks are 

displayed when the document is 

opened, we need to set the view 

property. 

5.  From the File menu, choose 

Properties. 

 
6.  Click on the Initial View tab. 

 
7.  From the Navigation tab list, choose 

Bookmarks Panel and Page or 

Attachments Panel and Page depending 

on your situation. 
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Final Editing 
 
 
 

Removing Links 

To remove  a specific hyperlink in a W ordPerfect document: 

Press Alt + 3 to open Reveal Codes. 

Place  your  cursor  in  front  of  the 

Hyperlink   coding   for  the  link  to  be 
removed. 

 
 
 

Press the Delete key. 
 
 
 

To remove  all hyperlinks in a W ordPerfect document: 

Press Alt + 3 to open Reveal Codes. 

Place  your  cursor  at the  beginning  of 
the text in the Reveal Codes box. 

Type Ctrl + F. 

A Find  and Replace  dialogue  box  will 

open. 

 

Select Match, then Codes.  
 

A Codes box will appear. 
 

In  Find  codes,  scroll  and  select 

Hyperlink Begin. 

Click Insert. 
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[HyperLink  Begin]  will  appear  in the 

Find: box. 
 

Replace   with  <Nothing>   and  select 

Replace All. 
 

 
 
 
 

A display will open stating how many 

hyperlinks   were   replaced   with 

“nothing.” 
 

Click OK. 
 

 
Editing Linked Text 

To make additions to or change hyperlinked text in a W ordPerfect document: 
 

1.  Place your cursor at the end of the linked text. 
 

2.  Use the back arrow on your keyboard to move your cursor into the 

linked text to the position where the text must me added or 

changed, and 
 

3.  Type in your changes. 
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Publish to PDF—Retaining the Hyperlinks 
 

All documents filed in CM/ECF are PDFs, so all documents created for filing must 

be converted to a PDF document.  To include hyperlinks in your filed documents, place 

all the links into the document using your word processing system before converting the 

document to a PDF format. 
 

Once all links are in the document, use your word processing software to save or 

convert your briefs, or other documents you have created for filing, in a PDF format. 
 

Note:  Do NOT use Print to PDF to create a PDF of a brief with hyperlinks–the 

hyperlinks will be lost.  Do NOT print the document and scan it to PDF format. 
 
Conversion to PDF 

To save (“publish”) a W ordPerfect document in PDF format: 
 

STEP ACTION 

1 Select File –> 

Publish To –> 

Publish to PDF. 

Or 

Type Alt + P. 

2 The Publish to PDF dialog box will 

open. 
 

Browse to the file location for 

saving the file. 
 

Name the file. 

Click Save. 

A PDF will be created with active 

links. 

3 After the document is published to PDF, you may filed it on CM/ECF 

using typical filing processes.  W ith the exception of filing a document 

with links to its own attachment (discussed previously), no special 

steps are needed for filing a hyperlinked document on CM/ECF. 
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Additional Tips 
 

Viewing a website location opened from a link in a CM/ECF filing: 

When opening a PDF document filed on CM/ECF,  make sure you are opening 

PDFs in your PDF software and not within the W eb browser itself.  Opening the 

CM/ECF  documents  in  the  web  browser  will  result  in  unnecessary  toggling 

between  the document  opened  on CM/ECF  and any website locations  opened 

from links within that CM/ECF document, and will make it difficult or impossible to 

display  the  CM/ECF  document  on  one  screen  and  the  website  location  on 

another. 
 

For those who use Adobe Acrobat, this setting adjustment is made as follows: 
 

 

With  an  Adobe  Acrobat 

document open, 
 

Click Edit, 
 

then Preferences. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

From the Categories, 

scroll and select Internet. 

 
 

Make sure Display PDF in 
browser is  not selected. 

 

 
 

Click OK. 
 
 
 
 
 
 
 

After  you  change  this  setting,  you  will  need  to close  and  reopen  your  W eb 

browser before opening CM/ECF filings. 
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This manual was based on the instructional guide produced by 

Magistrate Judge Cheryl Zwart of the District Court of Nebraska.  

Please share your comments, questions, corrections, and 

experiences with hyperlinking or using this Guide by contacting: 

 

 IT Department 

US District Court for the Central District of California  

(213) 894-6133  


